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Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards. 

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice. 

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired. 

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited. 

Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 

 
WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to 
personal injury or death, property damage, or economic loss. 

 

 
ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

 
IMPORTANT Identifies information that is critical for successful application and understanding of the product. 

Labels may also be on or inside the equipment to provide specific precautions. 

 
SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

 

 
BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous 
temperatures. 

 

 
ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will 
cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for 
Personal Protective Equipment (PPE). 

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication are not in 
alignment with the movement toward inclusive language in technology. We are proactively collaborating with industry peers to 
find alternatives to such terms and making changes to our products and content. Please excuse the use of such terms in our 
content while we implement these changes. 
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Preface 

This guide provides information and procedures for installing and upgrading 
a FactoryTalk® Batch system, which includes: 

• FactoryTalk Batch 
• FactoryTalk eProcedure® 
• FactoryTalk® Event Archiver Database, with Batch Reports and 

Database Management Tool 
• FactoryTalk Batch Material Manager 
• FactoryTalk® Batch View™ 

This guide is organized into a conceptual overview of a FactoryTalk Batch 
system that includes information about pre-installation administrative tasks, 
followed by installation and post-installation procedures for the different 
system components.  

Readers should be familiar with installing Windows applications and 
configuring operating system options. 

Before starting installation or upgrade of FactoryTalk Batch components, 
review FactoryTalk Batch release notes and product compatibility information 
at the Product Compatibility and Download Center (PCDC). 

Rockwell Automation publishes legal notices, such as privacy policies, license 
agreements, trademark disclosures, and other terms and conditions on the 
Legal Notices page of the Rockwell Automation website. 

End User License Agreement (EULA) 
You can view the Rockwell Automation End User License Agreement (EULA) 
by opening the license.rtf file located in your product's install folder.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf 

Open Source Software Licenses 
The software included in this product contains copyrighted software that is 
licensed under one or more open-source licenses.  

You can view a full list of all open-source software used in this product and 
their corresponding licenses by opening the oss_license.txt file located your 
product's OPENSOURCE folder on your hard drive. This file is divided into 
these sections: 

• Components 
Includes the name of the open-source component, its version number, 
and the type of license. 

About this manual 

Legal Notices 

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://www.rockwellautomation.com/global/legal-notices/overview.page
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• Copyright Text 
Includes the name of the open-source component, its version number, 
and the copyright declaration. 

• Licenses 
Includes the name of the license, the list of open-source components 
citing the license, and the terms of the license. 

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\Help\<product 
name>\Release Notes\OPENSOURCE\oss_licenses.txt  

You may obtain Corresponding Source code for open-source packages 
included in this product from their respective project web site(s). 
Alternatively, you may obtain complete Corresponding Source code by 
contacting Rockwell Automation via the Contact form on the Rockwell 
Automation website: 
http://www.rockwellautomation.com/global/about-us/contact/contact.page. 
Please include "Open Source" as part of the request text. 

 

This table is a comprehensive documentation  list for the FactoryTalk® Batch 
products from Rockwell Automation. 

Installation, Quick Start, and Getting Results Guides 
Resource Description 

FactoryTalk Batch Components Installation and 
Upgrade Guide 
(BATCH-IN002) 

Provides information and procedures for FactoryTalk Batch system installation. 
Includes information for FactoryTalk Batch Material Manager, FactoryTalk Event 
Archiver, and associated FactoryTalk Batch Client and Server components. 

FactoryTalk Batch View Quick Start Guide 
(FTBVS-QS001) 

Provides information about using FactoryTalk Batch View to create, view, and 
command control recipes, acknowledge prompts and signatures, view equipment 
phases and diagnostic information, and view profile information.  

FactoryTalk Batch View HMI Controls Quick Start 
Guide 
(BATCH-QS001D) 

Provides a general overview of FactoryTalk Batch View HMI Controls. 

FactoryTalk Batch eProcedure® Getting Results 
Guide 
(BWEPRO-GR011) 

Explains the basics of FactoryTalk Batch eProcedure. 

FactoryTalk Batch Getting Results Guide 
(BATCH-GR011) 

Introduces the basics of automated batch manufacturing and the FactoryTalk Batch 
product components. 

FactoryTalk Batch Material Manager Getting Results 
Guide 
(BWMTR-GR011) 

Introduces the basics of FactoryTalk Batch Material Manager. 

Additional resources 

http://www.rockwellautomation.com/global/about-us/contact/contact.page
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User Guides 
Resource Description 

FactoryTalk Batch Material Editor User Guide 
(BWMTR-UM001) 

Provides access to information and procedural instructions required to configure 
materials and the containers to hold them. The material data is stored in the material 
database, which is used to create material-based recipes. This information is 
intended as a reference for formulators. 

FactoryTalk Batch Equipment Editor User Guide 
(BATCH-UM004) 

Provides information on creating and maintaining an equipment database (area 
model). The area model is available to all other FactoryTalk Batch programs, including 
the Recipe Editor, Batch View, and Phase Simulator. 

FactoryTalk Batch PhaseManager™ User Guide 
(BATCHX-UM011) 

Describes the integration of the FactoryTalk Batch software with the Studio 5000 
Logix Designer® application and the Logix 5000™ family of controllers. 
The integration simplifies the configuration and maintenance of the FactoryTalk 
Batch automation system, provides better communication between the FactoryTalk 
Batch Server and the Logix 5000 controller, and significantly reduces the 
programming effort required to develop the phase logic code that resides in your 
Logix 5000 controller. 

FactoryTalk Batch Recipe Editor User Guide 
(BATCH-UM006) 

Provides instructions on using FactoryTalk Batch Recipe Editor to create and 
configure master recipes for use in batch automation. The interface is based on IEC 
61131-3 sequential function charts to organize recipes graphically into procedures, unit 
procedures, operations, and phases. Build recipes using either the SFC format or a 
table-based format. 

FactoryTalk Batch View HMI Controls User Manual 
(FTBVS-UM003) 

Provides details about using FactoryTalk Batch View HMI Controls to monitor and 
interact with the production process within a FactoryTalk View SE Display Client.  

FactoryTalk Batch View User Manual  
(FTBVS-UM002) 

Provides information and procedural instructions for using FactoryTalk Batch View in 
a modern and intuitive portal into a comprehensive batching solution for effective 
operations, leveraging its own web server using HTML5 technology to provide 
connectivity into a FactoryTalk Batch Server.  

FactoryTalk Event Archiver User Guide 
(BATCH-UM012) 

Provides information and instructions specific to the FactoryTalk Event Archiver. 
Intended for use by system administrators and production supervisors.  

Administrator Guides 
Resource Description 

FactoryTalk Batch Administrator Guide  
(BATCH-UM003) 

Provides instructions for configuring security and services, and implementation and 
use of components not typically accessed or used by batch operators, such as the 
FactoryTalk Batch Server. 

FactoryTalk Batch eProcedure Administrator Guide 
(BWEPRO-UM011) 

Provides procedures specific to FactoryTalk Batch eProcedure, such as implementing 
security and configuring the user-defined area Active Server Page. 
Included are instructions for tasks specific to FactoryTalk Batch, such as configuring 
security and services to support FactoryTalk Batch eProcedure. Provides instructions 
on the implementation and use of components not typically accessed or used by 
batch operators, such as the FactoryTalk Batch Server. 

FactoryTalk Batch Material Manager Administrator 
Guide 
(BWEPRO-UM011) 

Provides information and instructions specific to FactoryTalk Batch Material Manager. 
Intended for use by system administrators and database administrators. 
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Reference Guides 
Resource Description 

FactoryTalk Batch Material Server API Reference 
Manual 
(BWMTR-RM001) 

Provides access to information regarding the interface between the FactoryTalk Batch 
Material Server and the FactoryTalk Batch Material Editor and FactoryTalk Batch. It is 
intended to be used as a reference information by custom interface developers. 

FactoryTalk Batch PCD Programming Reference 
Manual 
(BATCH-RM004) 

Provides information and instructions about the FactoryTalk Batch PCD interface 
design. It is intended to be used as a reference guide for PCD programmers. 

FactoryTalk Batch Server API Reference Manual 
(BATCH-RM003) 

Provides information regarding the interface between the FactoryTalk Batch Server 
and FactoryTalk Batch View — the Server Application Programming Interface (API). It is 
intended to be used as a reference guide by custom interface developers. 

FactoryTalk Batch System Files Reference Manual 
(BATCH-RM005) 

Provides the technical information for configuration and maintenance of a 
FactoryTalk Batch system. It can be used as a reference information for 
implementation engineers and system administrators. 

FactoryTalk Batch eProcedure Instruction File 
Design Reference Manual 
(BWEPRO-RM001) 

Includes information about the building of instruction files for use in equipment 
database creation and recipe development. This information is intended to be used as 
a reference by instruction file authors. 

View or download publications at 
http://www.rockwellautomation.com/literature. To order paper copies of 
technical documentation, contact your local Allen-Bradley® distributor or 
sales representative. 

Rockwell Automation recognizes that some of the terms that are currently 
used in our industry and in this publication are not in alignment with the 
movement toward inclusive language in technology. We are proactively 
collaborating with industry peers to find alternatives to such terms and 
making changes to our products and content. Please excuse the use of such 
terms in our content while we implement these changes. 

 

https://www.rockwellautomation.com/literature
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Chapter 1 

FactoryTalk Batch system overview 

FactoryTalk Batch components are configurable products that help define, 
manage, monitor, and control manufacturing at local or remote sites. A 
typical FactoryTalk Batch architecture consists of one or more computers on a 
single network; there can be up to ten FactoryTalk Batch servers in a 
FactoryTalk Batch system that includes Material Manager. Review the 
application release notes, manuals, installation information for the 
FactoryTalk Batch components planned for your architecture before setting 
up the FactoryTalk Batch system. 

This diagram illustrates an example of a FactoryTalk Batch network. 

 

 Site Level  FactoryTalk View SE Display Clients with 
FactoryTalk Batch View HMI Controls 

 FactoryTalk Batch Material Manager 
Clients 

 FactoryTalk Batch Server, eProcedure Server, and 
FactoryTalk Batch View Server 

 FactoryTalk Batch Material Server   FactoryTalk Batch Server connects to SQL Server 
for Master Recipe Storage 

 SQL Server  FactoryTalk Batch View Clients 

 FactoryTalk Batch View Clients  Proprietary Network 

 TCP/IP  Process-Connected Device (PCD) 

 Plant Floor  FactoryTalk Event Archiver Database 
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Use these guidelines to decide where to place FactoryTalk Batch system 
servers on the network: 

• Install the eProcedure Server and the FactoryTalk Batch Server on the 
same computer. 

• Install the FactoryTalk Batch Material Manager Server on a computer 
with SQL Server. 

• Do not install the FactoryTalk Batch Material Manager Server on the 
same computer as the FactoryTalk Batch Server. 

• A maximum of ten FactoryTalk Batch Servers can exist in a FactoryTalk 
Batch network that includes FactoryTalk Batch Material Manager 
Server. 

• Install the FactoryTalk Event Archiver Database and Management Tool 
on a computer with SQL Server. 

• For best performance, install the FactoryTalk Event Archiver Database 
and Management Tool on a different computer than the FactoryTalk 
Batch Server.  

 

FactoryTalk Batch View is a modern, browser-based interface that allows you 
to initiate and control the batch process anywhere there is an internet 
connection. The FactoryTalk Batch View interface adapts across smartphones, 
such as iOS and Android, to tablets and PCs. Users can access real-time 
information and interact with their process from the plant floor to the 
production office. 

FactoryTalk Batch View is well-suited for large industrial facilities that have 
workstation infrastructure limitations and require multiple access points 
across the plant. With personalized user profiles that are tailored to the user, 
such as language switching options, workers at different levels of the 
organization can stay mobile yet connected to their process operations. 

Key capabilities of the solution include: 

• A modern web interface offers adaptation to new or existing platforms 
and environments with backward compatibility to previous versions of 
FactoryTalk Batch software; single-server architecture allows for new 
features and functions to be added with minimal impact to operations.  

• Information-enabled and secure. Uses common system security 
policies for access control similar to any workstation, as a node on the 
plant network. 

• Interfaces support multiple mobile devices and are easily integrated 
with HMI screens onto workstations. 

 

Server placement 
guidelines 

FactoryTalk Batch View 
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The FactoryTalk Batch View Server can be installed if you are choosing to 
install FactoryTalk Batch Server, or the current machine has installed 
FactoryTalk Batch Server.  

 
Tip: FactoryTalk Batch View performs best with Chromium-based browsers 
such as Google Chrome or Microsoft Edge. 

If you are using a FactoryTalk View SE Display Client, install the FactoryTalk® 
Batch View™ HMI controls to provide an interface that allows users to 
monitor and interact with the production process. The FactoryTalk Batch 
View HMI controls consist of: 

• BatchesList control: Creates control recipes, displays current control 
recipes, and commands a control recipe. In FactoryTalk View SE, maps 
to BatchViewHMI.BatchesList in the Insert an ActiveX Control dialog 
box and the Property Panel. 

• PromptsList control: Displays a list of prompts that are waiting to be 
acknowledged, a list of electronic signatures associated with a batch 
that are waiting for signoff, and instructions waiting to be 
acknowledged. In FactoryTalk View SE, maps to 
BatchViewHMI.PromptsList in the Insert an ActiveX Control dialog 
box and the Property Panel. 

• SFC control: Enables the ability to command batches during 
FactoryTalk View SE run-time on the Details and Summary pages of 
the SFC. In FactoryTalk View SE, maps to BatchViewHMI.SFC in the 
Insert an ActiveX Control dialog box and the Property Panel. 

• Full control: Accesses the entire FactoryTalk Batch View site. In 
FactoryTalk View SE, maps to BatchViewHMI.FullView in the Insert 
an ActiveX Control dialog box and the Property Panel. 

For more information about FactoryTalk Batch View, see the FactoryTalk 
Batch View online help.  

Review these minimum and recommended system requirements for 
installing, configuring, and running FactoryTalk Batch components. Unless 
noted these requirements assume that no other applications are installed on 
the computer. Preferred operating systems and software applications are 
prioritized for support, testing, and post-release patch qualifications. 

Hardware requirements 
• Server requirements 

• 8 GB of RAM memory 
• 100 GB free hard disk space 
• Intel® Core™ i5 standard power processor or greater 

• Client requirements 

• 4 GB of RAM memory 
• 30 GB free hard disk space 

Installation information 
about FactoryTalk  
Batch View 

System requirements  
and supported  
software overview 
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• Intel Core i5 standard power processor or greater

Supported operating systems 
• Windows Server®

• Windows Server 2022 Standard Edition (preferred) 
• Windows Server 2019 Standard Edition (preferred) 
• Windows Server 2022 DataCenter Edition
• Windows Server 2019 DataCenter Edition

• Windows®

• Windows 11 Professional (64-bit) (preferred) 
• Windows 10 Professional (64-bit) Build 1909 or later (preferred) 
• Windows 11 Enterprise (64-bit) 

• Windows 10 Enterprise (64-bit) Build 1909 or later
Tip: The installer software inhibits installation of FactoryTalk software on all Windows 7 
and 32-bit operating systems, including Windows 10 (32 bit). 

Supported database applications 
(for storing recipes, materials, reports, and journal archives) 

• SQL Server®

• SQL Server 2022 (English version only) 
• SQL Server 2019 (English version only) 

Web browsers 
(for FactoryTalk Batch View only) 

• Google® Chrome™ browser (preferred) 
• Microsoft Edge™ based on Chromium version:  80.0.361.50 or higher
• Apple® Safari®
• Firefox®

Logix firmware requirements 

(for FactoryTalk Batch only) 

• Firmware v18 or later on ControlLogix 5570 and CompactLogix 5370
family of controllers – for integration of PhaseManager with
FactoryTalk Batch

• Firmware v32 or later on ControlLogix 5580 and CompactLogix 5380
family of controllers – for integration of PhaseManager with
FactoryTalk Batch
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• Firmware v29 or later - for integration of SequenceManager with 
FactoryTalk Batch 

Logix Designer requirements 
(for FactoryTalk Batch only) 

• Studio 5000 Logix Designer v18 or later - for synchronization of 
PhaseManager with FactoryTalk Batch Equipment Editor 

FactoryTalk View SE requirements 
(for integration of FactoryTalk Batch View HMI Controls and legacy 
FactoryTalk Batch ActiveX controls only) 

• FactoryTalk View SE v14.0 (preferred) 
• FactoryTalk View SE v13.0  

Rockwell Automation Test Environment 
Rockwell Automation tests software products under a standard configuration 
of operating systems and antivirus software. For additional information, see 
the Knowledgebase Document ID: PN24 - Rockwell Software Products and 
Antivirus Software. 

Warranty 
The warranty does not cover systems that do not meet the minimum 
requirements for the version of software. 

IMPORTANT FactoryTalk Batch components for version 16.00 support only the U.S. English versions 
of operating systems. For more information about supported operating systems and 
other Rockwell Software product version support, refer to the Product Compatibility 
and Download Center (PCDC). 

• The FactoryTalk Batch Server computer cannot be configured as a: 

• Domain controller 
• DHCP server 
• WINS server 
• RAS server 
• DNS server 
• Master Browser 

• The FactoryTalk Batch Server computer does not support replication. 
• Install FactoryTalk Batch software on an NTFS formatted hard drive, 

as Windows security features are available only for drives formatted to 
use NTFS. 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/35330
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/35330
http://rok.auto/pcdc
http://rok.auto/pcdc
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• Warranty does not cover systems with modified DCOM configuration 
settings. Configuring settings using DCOMCNFG may stop the 
FactoryTalk Batch Server and prevent the FactoryTalk Batch Service 
Manager from functioning correctly. 

IMPORTANT FactoryTalk Batch version 16.00 components do not support touch screen 
technology. 

 

After completing the pre-installation administrative tasks, follow the 
installation instructions for each computer in the system, or repeat the 
installation instructions for several computers based on your FactoryTalk 
Batch system configuration. For example, if the FactoryTalk Batch system 
includes a FactoryTalk Batch Server and several FactoryTalk Batch Clients, 
determine which components to install on each computer. Each set of 
installation instructions includes a checklist of all related tasks and specific 
post-installation tasks for the component.  

• Install FactoryTalk Batch Server, FactoryTalk eProcedure Server, and 
FactoryTalk Event Archiver on page 29 

• Install FactoryTalk Batch Client components on page 43 
• Install FactoryTalk Batch Material Manager Server components on 

page 45 
• Install FactoryTalk Batch Material Manager Client components on 

page 49 

If you are upgrading your system from a previous version of FactoryTalk 
Batch use the Upgrade FactoryTalk Batch on page 53 instructions. 

 

Select installation 
instructions for  
each computer 
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Chapter 2 

Pre-installation administrative tasks 

This section describes administrative tasks to perform before installing 
FactoryTalk Batch components. Tasks include: 

• Obtain administrator privileges on target computer on page 17 
• Prepare the operating system on page 17 
• Create users and user groups on page 19 
• Update Windows Firewall settings on page 21 
• Configure the Remote Registry service on page 22 
• Set the system date and time on page 22 
• Prepare the SQL Server installation on page 22 

 

To install each of these software applications on the target computer, you 
must be logged onto the computer using an account that has administrator 
privileges on the computer and that has been granted permission to create 
databases, stored procedures, and logins on SQL Server. 

• FactoryTalk Batch Server 
• FactoryTalk Event Archiver 
• FactoryTalk eProcedure Server 
• FactoryTalk Batch Material Manager Server 
• FactoryTalk Batch Material Manager Client 

Before starting the installation procedure close any open applications. 

 

Before installing FactoryTalk Batch Server, FactoryTalk Material Manager 
Server,  or FactoryTalk eProcedure Server components make sure that the 
operating system for the target computer is properly configured.  

Server operating systems and desktop operating systems have different 
configuration requirements.  

Pre-installation configuration task include: 

• Configure the Windows Server operating system 
• Configure the Windows desktop operating system 

If setting up new computers for the FactoryTalk Batch system, install the 
operating system using the default settings. Then configure the operating 
system as described for the components.  

Obtain administrator 
privileges on  
target computer 

Prepare the  
operating system 

Windows configuration 
requirements 
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Tip: All supported operating systems are tested and warrantied for 
FactoryTalk Batch version 16.00. 

 

Configure the Windows Server operating system features to support 
FactoryTalk Batch Server, FactoryTalk Batch Material Manager Server, or 
FactoryTalk eProcedure Server. 

 
Tip: FactoryTalk Batch Server does not require any additional configuration of Windows Server 2019 
or 2022. However, If you are using Windows Server to host your Batch and eProcedure Server, ensure 
that the Internet Explorer Enhanced Security Configuration setting on the server has been turned off. 
For instructions, see the Microsoft Web site. 

To configure the Windows Server operating system  
1. If installing FactoryTalk Batch Server enable the required server 

features:  

• In Server Manager, select Add Roles and Features. 
• In Add Roles and Features Wizard, select Next.  
• For Installation Type, select Role-based or feature-based 

installation. 
• For Server Selection, choose Select a server from the server pool, 

and then choose the appropriate server from the Server Pool list 
and then select Next. 

2. If installing FactoryTalk Batch Material Manager Server go to 
Features, and select Message Queuing. 

3. Verify the selections, and then select Install.  
4. When the installation process is complete, select Close. 

 

Perform this procedure to configure the Windows desktop operating system 
for the FactoryTalk Batch Material Manager Server and FactoryTalk 
eProcedure Server. Use the Turn Windows features on or off control panel 
item for this configuration process.  

 
Tip: FactoryTalk Batch Server and Client components do not require any additional configuration for 
Windows desktop operating systems. 

To configure Windows desktop operating system 
1. On the computer where the FactoryTalk Batch Material Manager 

Server or FactoryTalk eProcedure Server will be installed, select 
Control Panel > Programs > Turn Windows features on or off.  

Windows Features opens. 

Configure the Windows 
Server operating system  

Configure the Windows 
desktop operating system 
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Tip: In Windows Features the box next to the feature name represents the 
installation status of the feature: 
• A checkmark represents a fully installed feature. 
• A black square represents an installed feature with optional features that 

are not enabled. 
• Empty boxes represent uninstalled features. 

2. If installing FactoryTalk Batch Material Manager Server select 
Microsoft Message Queue (MSMQ) Server. Microsoft Message Queue 
(MSMQ) Server Core is selected by default. 

3. Select OK to enable the features and close the dialog box. 

 

Data Execution Prevention (DEP) uses hardware and software security 
features to prevent the execution of malicious code in Windows operating 
systems. 

Rockwell Automation supports DEP OptIn and OptOut settings. For more 
information, see Microsoft KB article 875352. 

Before installing FactoryTalk Batch, you must create at least one domain user 
account that serves as the FactoryTalk Batch Server user account. If your 
installation includes FactoryTalk Batch Material Manager Server you must 
also create several domain user groups. When you run the installation 
program you need to provide the FactoryTalk Batch Server user account and 
password for the FactoryTalk Batch Server and provide the FactoryTalk Batch 
Material Manager Server user account and password for the FactoryTalk 
Batch Material Manager Server to run under. 

FactoryTalk Batch users/user groups 
The installation of the FactoryTalk Batch Server creates the Windows user 
group batchsvr_group on the FactoryTalk Batch Server. This group is 
automatically assigned all the user rights and default access permissions 
required for the FactoryTalk Batch Server to function correctly. 

The installation adds the FactoryTalk Batch Server user account to the 
following:  

• Administrators group 
• batchsvr_group 
• MasterRecipeAuthor 
• MasterRecipeViewer 
• Batch COM+ Application 
• FactoryTalk Batch Server service 
• FactoryTalk Event Archiver service 
• FactoryTalk eProcedure Server service (eProcedure Server installation) 

DEP settings 

Create users and  
user groups 

https://support.microsoft.com/en-us/help/875352/a-detailed-description-of-the-data-execution-prevention-dep-feature-in
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The services for the FactoryTalk Batch Server, FactoryTalk Event Archiver, 
FactoryTalk eProcedure Server, and the Batch COM+ Application require 
identical user accounts to support the FactoryTalk Batch Server functionality. 

FactoryTalk Batch Material Manager user groups 
For FactoryTalk Batch Material Manager, you must create these required 
domain user groups. 

The installation of FactoryTalk Batch Material Manager Server creates the 
Windows user group MTUsers on the FactoryTalk Batch Material Manager 
Server. This group is automatically assigned all the user rights and default 
permissions required for the FactoryTalk Batch Material Manager Server fot 
function correctly. 

The installation adds the FactoryTalk Batch Material Manager Server user 
account to the following: 

• Administrators group 
• MTUsers 

Required domain user groups 

• MTBatchServer 

Add the FactoryTalk Batch user account under which the FactoryTalk 
Batch Server service is running to the MTBatchServer group. This is 
the group that the FactoryTalk Batch Server uses to access the material 
database. 

• MTGeneral 

Required for Material Editor use.  

• MTLotAuthor 

Add any domain users that require the ability to add, edit, and delete 
material lots in the Material Editor. 

• MTMaterialAuthor 

Add any domain users that require the ability to add, edit, and delete 
materials and containers in the Material Editor. 

• MTMaterialViewer 

Add any domain users that require read-only access to materials and 
containers in the Material Editor. The installation adds the five domain 
groups and domain user account for the FactoryTalk Batch Material Manager 
Server to the appropriate COM+ roles and/or local user groups. For more 
information about security settings, see Security settings in the FactoryTalk 
Batch Material Manager Administrator Guide. 
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To allow the installation program to configure the firewall exceptions 
automatically, enable the Windows Firewall Service prior to installation. The 
installation program uses the Rockwell Software Windows Firewall 
Configuration Utility to add the necessary exceptions.  

IMPORTANT When managing the Windows Firewall settings externally, the installation program 
cannot change the Windows Firewall settings.  

The installation program updates Windows Firewall settings to allow these 
applications to communicate through the firewall:  

• FactoryTalk Batch Server 
• FactoryTalk Event Archiver 
• FactoryTalk eProcedure Server 
• FactoryTalk Batch Material Manager Server 
• FactoryTalk Batch Material Manager Client 

Typically, Windows Firewall appears under Control Panel > System and 
Security > Windows Firewall. For more information, see the Windows 
operating system for the current installation.  

 

If the Windows Firewall is enabled when you install FactoryTalk Batch or 
FactoryTalk eProcedure applications, the installation program adds the 
following exceptions to the local computer: 

Windows Firewall Exceptions 

• batchsvr.exe (Batch server installs) • OPCEnum.exe 
• batchvew.exe (Batch client installs) • Port 1433 TCP (SQL Server installs) 
• DaClient.exe • Port 137 NetBIOS Name Service 

• EventClientMultiplexer.exe • Port 135 TCP 
• EventServer.exe • Port 80 TCP (FactoryTalk eProcedure Client installs) 
• Flexsvr.exe • RDcyHost.exe 
• FTCounterMonitor.exe • RnaDiagnosticsSrv.exe 
• FTSPVStudio.exe • RnaDiagReceiver.exe 
• FTSysDiagSvcHost.exe • RnaDirServer.exe 
• iexplore.exe • RsvcHost.exe 
• Imgrd.exe • VStudio.exe 
• NmspHost.exe  

If the Windows Firewall is enabled, and not externally controlled, the 
Windows Firewall Configuration Utility runs automatically during 
installation. If this utility does not run automatically, manually run it on each 
computer in your FactoryTalk Batch system after installing servers or clients. 

To manually run the FactoryTalk Windows Firewall Configuration Utility, 
navigate to Start > Rockwell Software > Windows Firewall Configuration 
Utility.  

IMPORTANT If you are using a different firewall with your system, add equivalent exceptions to 
enable communication through the firewall by the FactoryTalk Batch components. 

Update Windows  
Firewall settings 

Windows Firewall 
exceptions 
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Remote Registry must be enabled to support network synchronization of the 
FactoryTalk Batch components across computer boundaries. Remote Registry 
is disable by default on standard Windows computers. Before installing the 
FactoryTalk Batch Server or FactoryTalk Batch Material Manager Server on 
any operating system, configure the Remote Registry service for automatic 
startup. 

 
Tip: The setup wizard will not permit you to install the FactoryTalk Batch components if the Remote 
Registry service is not enabled. 

To configure the Remote Registry service 
1. Navigate to Control Panel > System and Security > Administrative 

Tools. Double-click Services. 
2. In the Services (Local) pane, right-click Remote Registry and select 

Properties. 
3. For Startup type, select Automatic. 
4. Select OK. 

 

Set the date and time on each computer on the FactoryTalk Batch network to 
the same date and time. 

IMPORTANT The dates and times for all computers on the network must match each other so that 
events, journals, and logs in the FactoryTalk Batch system are properly synced. 

 

These applications can use SQL Server:  

• FactoryTalk Batch Server (to store recipes in RDB format) 
• FactoryTalk Event Archiver (to archive batch event records and to use 

Batch reports) 
• FactoryTalk Batch Material Manager Server (to store materials for 

recipes) 

Install a supported version of SQL Server as listed in the System 
requirements and supported software overview section and select these 
features: 

• Database Engine Services  
• Reporting Services (if using FactoryTalk Event Archiver with Batch 

reports) 
IMPORTANT Configuration of SQL Server Reporting Services differs depending on the 

version of SQL Server installed. Reporting Services for SQL Server 2017 and later 
are installed separately. 

Configure the Remote 
Registry service  

Set the system date  
and time 

Prepare the SQL  
Server installation 
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Visit the Microsoft website 
(https://www.microsoft.com/en-us/sql-server/sql-server-downloads) to get 
the latest supported version of SQL Server for the FactoryTalk Batch system. 

Consider these items when installing SQL Server for use with the FactoryTalk 
Batch system:  

• Before starting the FactoryTalk Batch installation create a SQL Server 
database login for the user that will performing the FactoryTalk Batch 
installation. Make sure that the user account has been granted 
dbcreator permissions in SQL Server. That permission is required to 
create a database. 

• The user installing FactoryTalk Batch Material Manager must have 
Read and Write access to the SQL Server database.  

• SQL Server can reside on the same computer as the FactoryTalk Batch 
Server. 

• If using a single SQL Server installation, install SQL Server on the 
same computer where the FactoryTalk Batch Material Manager Server 
will be installed. 

• If using a single SQL Server installation for recipes, Batch reports, and 
materials, use the default instance name (MSSQLSERVER). The 
FactoryTalk Batch Material Manager Server supports only default 
instances. 

• Support for named instances: 

• FactoryTalk Batch and the FactoryTalk Batch Material Manager 
Server do not support named instances.  

• FactoryTalk Event Archiver supports named instances. 

• Add TCP Port 1433 as an exception in the Windows Firewall to store 
recipes from FactoryTalk Batch Recipe Editor on a remote SQL Server. 

• Install the FactoryTalk Event Archiver Management Tool on the same 
computer as SQL Server. 

For SQL Server installation instructions, see the SQL Server Installation Guide 
on the Microsoft website. 

 

If using SQL Server 2019 or SQL Server 2022, you must install SQL Server 
Reporting Services to create FactoryTalk Batch reports using FactoryTalk 
Event Archiver. 

You can download Reporting Services from the Microsoft web site at the 
following locations: 

• SQL Server 2022 Reporting Services 
• SQL Server 2019 Reporting Services 

Update Reporting Services 
for SQL Server 2019 or SQL 
Server 2022 

https://www.microsoft.com/en-us/sql-server/sql-server-downloads
https://docs.microsoft.com/en-us/sql/database-engine/install-windows/install-sql-server?view=sql-server-ver15
https://www.microsoft.com/en-us/download/details.aspx?id=104505
https://www.microsoft.com/en-us/download/details.aspx?id=100122
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To update Reporting Services for SQL Server 2019 or SQL Server 2022 
1. Go to the location where you downloaded Report Services. Right-click 

SQLServerReportingServices.exe and select Run as administrator to 
start the installer. 

2. On the Welcome page, select Install Reporting Services. 
3. In Choose an edition to install either select the Developer free edition 

or enter your product key and then select Next. 
4. Read and agree to the license terms and conditions and then select 

Next. 
5. Select Next to install the report server only. 

Reporting Services uses the Database Engine installed with SQL Server 
to store the report server database.  

6. In Specify an install location accept the default location for the report 
server. Select Install to continue. 

 
Tip: The default path is C:\Program Files\Microsoft SQL Server Reporting 
Services. 

7. If prompted to restart your computer, do so. 

 

Before you can install FactoryTalk Batch with FactoryTalk Event Archiver, you 
must configure the Web Service URL, database and Web Portal URL. 

To configure Reporting Services for SQL Server 2019 or SQL  
Server 2022 

1. In the Windows search bar, type Report Server Configuration 
Manager and then select the app to open it.  

2. In Report Server Configuration Connection, select the report server 
instance to configure. 

a. In Server Name, specify the name of the computer on which the report 
server instance is installed. 

b. In Report Server Instance, select the SQL Server Reporting 
Services instance to configure.  
Only report server instances for this version of SQL Server appear 
in the list. 

c. Click Connect. The Report Server Configuration Manager opens.  

3. On the left pane, select Web Service URL. 
4. Select Apply to accept the default values. Observe the Results pane. If 

all tasks completed successfully, continue the configuration.  
5. On the left pane, select Database. 
6. Under Current Report Server Database, select Change Database to 

open the Report Server Database Configuration Wizard. 

Configure Reporting 
Services for SQL Server 
2019 or SQL Server 2022 
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7. On the Action page, select Create a new report server database then 
select Next. 

8. On the Database Server page complete the settings: 

• In Server Name type the name of the SQL Server.  
• In Authentication Type select Current User - Integrated Security. 
• Select Test Connection to verify the user account can login to the 

server. 
• Select Next. 

9. On the Database page, in Database Name provide a name for the 
initial reporting database and then select Next. 

10. On the Credentials page specify an existing account that the report 
server will use to connect to the report server database and then select 
Next. 

11. On the Summary page confirm the settings are correct and then select 
Next.  

12. Once the report server database is created, select Finish to close the 
wizard. 

13. On the left pane, select Web Portal URL. 
14. Select Apply to accept the default values. Observe the Results pane. If 

all tasks completed successfully, continue the configuration.  
15. In the Web Portal URL pane (on the right), select the URLs: link to 

open SQL Server Reporting Services in a web browser. 
IMPORTANT If this is the first time accessing the SQL Server Reporting 

Services page, depending on your browser security settings, 
you might receive several warning messages. To continue, 
select Close or Add for each warning. 

16. In Execution Account, select Specify an execution account. 
17. In Account enter the domain\user name and password that was used 

when SQL Server was installed. 

 
Tip: Make sure that the group or user specified is granted EXECUTE and INSERT permissions 
to the BatchHistoryEX and ReportServer databases after installation is complete. 

18. Select Apply. Observe the Results pane and verify the task completed 
successfully. 

 

If you are running Windows Firewall on the same computer as the SQL 
Server, remote connections to the SQL Server will be blocked unless the SQL 
Server and SQL Browser service can communicate through the firewall. You 
will have to add an exception in Windows Firewall for these services to make 
connection from the FactoryTalk Batch Archiver client to the remote 
FactoryTalk Batch Archiver SQL Server. 

By default, SQL Server uses static TCP port number 1433 for the default 
instance MSSQLSERVER. If you configure SQL Server to use a static port 
other than the default port add that port to the firewall exception list instead 
of the default port.  

Configure Windows Firewall 
for FactoryTalk  
Event Archiver 
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Alternatively, you can configure SQL Server to use a dynamic port. If you use 
dynamic port allocation, you specify port number zero in the network 
configuration. Once SQL Service restarts, it requests a free port number from 
the operating system and assigns that port to SQL Server. When dynamic 
ports are used, the SQL Browser service provides the port number to the 
requesting FactoryTalk Batch component. 

To configure Windows Firewall for a SQL Server using static ports 
1. On the client computer, open Windows Defender Firewall and choose 

Advanced Settings. 
2. Select Inbound Rules and click New Rule. 
3. Follow the New Inbound Rule Wizard making these selections: 

d. For Rule Type, select Port and then click Next. 

e. For Protocol and Ports, select TCP and enter the port 1433 (default) 
or the static port number configured for SQL Server and then click 
Next. 

f. For Action, select Allow the Connection and then click Next. 

g. For Profile, select the appropriate network profile (Domain, 
Private, or Public) and then click Next.  

h. (optional) For Name, type a name and description for the inbound 
rule. Click Finish. 

4. Click New Rule again to create another inbound rule. 
5. Follow the New Inbound Rule Wizard making these selections: 

i. For Rule Type, select Port and then click Next. 

j. For Protocol and Ports, select UDP and enter the port 1434 and then 
click Next. 

k. For Action, select Allow the Connection and then click Next. 

l. For Profile, select the appropriate network profile and then click 
Next. 

m. (optional) For Name, type a name and description for the inbound 
rule. Click Finish. 

 

To configure Windows Firewall for a SQL Server using dynamic ports 
1. On the client computer, open Windows Defender Firewall and choose 

Advanced Settings. 
2. Select Inbound Rules and click New Rule. 
3. Follow the New Inbound Rule Wizard making these selections: 
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n. For Rule Type, select Program and then click Next. 

o. For Program, select This program path and then click Browse. 

p. Enter the path to your SQL Server executable then click Open.  
Example: C:\Program Files\Microsoft SQL 
Server\MSSQL17.MSSQLSERVER\MSSQL\Binn\sqlservr.exe.  

q. Confirm the path is correct and then click Next. 

r. For Action, select Allow the Connection and then click Next. 

s. For Profile, select the appropriate network profile and then click 
Next.  

t. (optional) For Name, type a name and description for the inbound 
rule. Click Finish. 

4. Click New Rule again to create another inbound rule. 
5. Follow the New Inbound Rule Wizard making these selections: 

u. Select Port radio button on the first page and then click Next. 

v. Select UDP and enter the port 1434 and then click Next. 

w. Select Allow the Connection and then click Next. 

x. Select the appropriate network profile and then click Next. 

y. (optional) Add a name and description for the inbound rule. Click 
Finish. 

After completing these steps the FactoryTalk Event Archiver client will be able 
to connect to the FactoryTalk Event Archiver remote SQL Server. 
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Chapter 3 

Install FactoryTalk Batch Server, FactoryTalk 
eProcedure Server, and FactoryTalk  
Event Archiver 

Installing the FactoryTalk Batch Server, eProcedure Server and FactoryTalk 
Event Archiver software requires that you perform pre-installation tasks to 
prepare your environment before installing the software. After the installation 
is complete, you will perform some post-installation configuration to get your 
system ready for production use. 

This section provides instructions for installing the FactoryTalk Batch Server, 
eProcedure Server, and FactoryTalk Event Archiver software on the same 
computer. 

 
Tip: We recommend using the default installation directories for all components. 

Use this checklist to help you successfully set up the FactoryTalk Batch 
environment: 

Pre-Installation administration tasks 

 Tasks Notes 
 Obtain administrator privileges on target 

computer 
 

 Create users and user groups  

 Update Windows firewall settings  

 Configure the Remote Registry service  
 Set the system date and time  
 Prepare the SQL Server installation  

Pre-Installation operating system configuration 

 Configure the Windows Server operating 
system for the FactoryTalk Batch Server and 
eProcedure Server 

 

 Configure the Windows desktop operating 
system for the FactoryTalk Batch Server and 
eProcedure Server 

 

Installation 
 Install the FactoryTalk Batchcomponents  
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 Run FactoryTalk Updater to check for updates 
the components on page 33 

 

Post-Installation configuration  

 Configure the FactoryTalk network directory  

 Configure <MSSQL> to enable FactoryTalk 
Event Archiver with Reporting Services  
• Configure SQL Server 2019 or SQL Server 

2022 to enable FactoryTalk Event Archiver 
with Reporting Services on page 36 

 

 Grant access to the FactoryTalk Batch 
directory on the SQL Server computer 

 

 Add a server to the FactoryTalk Batch system  

 Configure event log settings on page 38  
 Create a shared directory on page 38  
 Define redundant servers (optional) on page 39  
 Configure server options on page 40  
 Set security on logs and journals folders on 

page 41 
 

 Configure browser compatibility view settings  

 

 

After preparing the computer operating systems, install the FactoryTalk Batch 
Server, FactoryTalk eProcedure Server, FactoryTalk Batch View Server, and 
FactoryTalk Event Archiver components.  

• The FactoryTalk Batch Server controls system information, phases, 
and recipes.  

• The FactoryTalk eProcedure Server: 

• Provides services to the FactoryTalk Batch Server to use HTML 
instruction files. 

• Formats parameters and report parameters from material-based 
recipes into instruction files. 

• The FactoryTalk Event Archiver stores the FactoryTalk Batch ASCII 
electronic batch records (.evt or evtj files) into a SQL Server database. 
The database can be queried for batch data or can be used by the 
optional FactoryTalk Batch reporting tools to generate web-based 
batch reports. 

 
Tip: Prerequisite checks are run automatically to ensure a successful 
installation. If an issue occurs during installation, an error message with 
steps to resolve is displayed.  

Install the FactoryTalk 
Batch components 
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Default installation of FactoryTalk Batch components 
The default FactoryTalk Batch installation includes: 

• FactoryTalk Services Platform v6.40.00 (always installed with 
FactoryTalk Batch, FactoryTalk eProcedure, and FactoryTalk 
Batch Material Manager).

• FactoryTalk Activation Manager v5.01.00 (always installed with 
FactoryTalk Batch, FactoryTalk eProcedure, and FactoryTalk 
Batch Material Manager).

• FactoryTalk Linx v6.40.00 (always installed with FactoryTalk Batch, 
FactoryTalk eProcedure, and FactoryTalk Batch Material Manager).

• FactoryTalk Batch v16.00 (includes Batch Server and Editors).
• FactoryTalk Batch View Server (v3.00; installed only if FactoryTalk 

Batch is selected to be installed or has been installed). 
• FactoryTalk Event Archiver Components v16.00 (includes 

Database and Reporting Services and Management Tool).
• Tools (FactoryTalk Updater Agent v4.10.00). 

Optional components available for installation are: 

• FactoryTalk eProcedure Server v16.00
• FactoryTalk Batch Material Manager v16.00 (includes Server

Components and Client Components).
• FactoryTalk Batch View HMI Controls 3.00. 

IMPORTANT Install FactoryTalk Batch server and eProcedure server using the same user. 

Tip: If you had a previous installation of eProcedure, the install program asks if you want to copy the 
content from the previous eProcedure Client content location to the Batch View Server customer 
content folder. If the content is not copied to the new folder the content remains in the previous 
eProcedure Client content location which is no longer used by the eProcedure Server to support 
eProcedure instructions.    

To install the FactoryTalk Batch Server, FactoryTalk eProcedure, 
FactoryTalk Batch View Server, and FactoryTalk Event  
Archiver components 

1. Run Setup.exe.
2. On the Setup page, select Customize.
3. On the Customize page:

• Select and then expand FactoryTalk Batch v16.00. The Batch Server
and Editors options are installed by default. Clear Batch Editor to
remove it from the installation. Clear the Bach Server to remove
FactoryTalk Linx, FactoryTalk Activation Manager, FactoryTalk
Batch Server and FactoryTalk Batch View Server. Removing both
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options removes FactoryTalk Batch and all other default 
components from the installation. 

• Select and then expand FactoryTalk Event Archiver Components 
v16.00. The Database and Reporting Services and Management 
Tool options are installed by default. Clear either option to remove it 
from the installation. Removing both options removes FactoryTalk 
Event Archiver Components v16.00 from the installation. 

• Select FactoryTalk eProcedure Server v16.00 to include eProcedure 
in your installation. 

• Select and then expand Tools. FactoryTalk Updater Agent v4.10.00 
is installed by default. Clear the option to remove it from the 
installation.  

4. On the FactoryTalk Services Platform page: 

• Choose the directory type that you want to create, and select Next.  

5. On the Permission Requested page:  

• Select Yes, allow changes to this computer. 

6. On the Options page: 

• FactoryTalk Network Directory is required. 
• In HTTPS Port enter a port to use for the FactoryTalk Batch View 

Server. Port 3443 is the default and is the recommended port.  
• Select Next. 
• If upgrading a FactoryTalk eProcedure Server from v14.00, select 

Yes to have the installation program copy your content from 
\Program Files (x86)\Rockwell Software\Batch\Web\eProcedure 
Client to \Program Files (x86)\Rockwell Software\Batch View 
Server\customercontent. 

 
Tip: If you select No, you must manually copy the content after installation to continue 
using the content with your instructions. 

7. On the Batch System Details page, complete these fields:  

• In User Name, enter the domain\user name for user account 
created for the FactoryTalk Batch Server Service to run under. If 
the user account is in the current domain, the domain does not need 
to be specified.  
To use a local account instead of a domain account, type .\local 
user name. 

• In Password enter the password for the domain\user name.  
• In Event File Format, select one formatted file type generated by the 

Batch Server. 
• Select Next. 

8. (optional) On the Event Archiver SQL Connection page, if installing 
FactoryTalk Event Archiver components, complete these items: 

• In Server Name, enter the SQL Server name. 
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• In Instance Name, enter the instance name if using a named 
instance.  

 
Tip: If using a single SQL Server installation for recipes, Batch reports, and 
materials, use the default instance name MSSQLSERVER. The FactoryTalk 
Batch Material Server supports only default instances. 
If using multiple SQL Server installations, FactoryTalk Event Archiver Batch 
Reports support named instances. 

• In Data Source Name, enter the data source name. 
• Under Reporting Services, select Include Batch Reports. 
• Confirm that the Web Service URL is correct. If you are using a 

different port for the Report Server web service, please update the 
Web Server URL manually. 

• Select Next.  

9. On the Connection Validated page, select Install.  
10. On the End User License Agreements page, review the agreement and 

select Accept all. 
11. If the Would you like to install this device software page appears, 

select Install.  

 
Tip: The installation progress wheel and the specific components and supporting 
files are displayed. 

12. (optional) If prompted on the Almost There page, select Activate your 
software, and then select Next. 

13. If prompted on the That's it page, restart the computer.  

 

When you start the installation process for your FactoryTalk Batch system one 
of the optional installation components is FactoryTalk Updater. FactoryTalk 
Updater assists in management of installed Rockwell Automation software by 
announcing new versions and patch roll-ups for the software on your 
computer. Registering for updates is not required to receive announcements 
from the FactoryTalk Updater. System logs and some application data are 
stored in this folder: 

C:\Users\Public\Documents\Rockwell\Updater\Data 

The logs and application data can be helpful when contacting Rockwell 
Automation Technical Support. System logs are automatically deleted after 90 
days. 

Firewall ports and URL access 
During operation, FactoryTalk Updater opens these firewall ports on the 
server: 

Port Type Port Number Description 
TCP 808 Allows the Updater agent and client to connect to the Updater server. 
UDP 137 Used to ping computer names. 
Network-Echo Request (ICMPv4-In) Allows one computer to contact or ping another computer to test network communications. 

FactoryTalk Updater 
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During operation, FactoryTalk Updater opens these firewall ports on the 
agent: 

Port Type Port Number Description 
TCP 30064 Allows access to the agent service to change the server address. 
UDP 3702 Allows Auto Discovery broadcast message. 
UDP 137 Used to ping computer names. 
Network-Echo Request (ICMPv4-In) Allows one computer to contact or ping another computer to test network communications. 

To ensure FactoryTalk Updater can access the Product Compatibility and 
Download Center (PCDC) data and download the latest patches, add these 
URLs to the firewall exception list: 

• When using the server installation: 
api.rockwellautomation.com 

• When using the client installation: 
idp.rockwellautomation.com 
netstorage.rockwellautomation.com 

See the FactoryTalk Updater help for more information about using 
FactoryTalk Updater. 

Use the Modify and Repair installation method to change the optional 
components selected with the FactoryTalk Batch system installation or to run 
a repair operation on installed components. If the FactoryTallk Batch 
(includes Batch Server and editors), FactoryTalk Batch View Server, 
FactoryTalk Event Archiver Components, Tools (FactoryTalk Updater Agent 
v4.10.00) have been installed when the installation program is started, an 
option to modify the current installation is displayed in the installation 
wizard. You can also access Modify and Repair by opening Windows Control 
Panel and selecting Change for a Rockwell Automation software application. 

Options for modifying an installation vary, based on the components 
installed. Options that are supported and not supported when modifying an 
installed component are:  

Component Supported when modifying an install Not supported when modifying an install 

FactoryTalk Batch 
FactoryTalk eProcedure 
FactoryTalk Material Manager 

• Adding a client to an existing server 
installation 

• Adding a server to an existing client 
installation 

• Removing the individual client or server 

FactoryTalk Event Archiver • Adding the Management tool to an 
existing Database install if the 
Include Batch Reports option was 
selected during the initial installation 

• Adding the Management tool to an existing 
Database installation if the Include Batch 
Reports option was not selected during the 
initial installation 

• Adding the Database to an existing 
Management tool installation 

• Removing the individual Database or 
Management Tool installation 

Modify an installation 
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To modify an installation 
1. Run Setup.exe. 
2. On the Setup page, select Modify. 
3. On the Modify page, select the components to install. 
4. Select Next. 
5. Complete any remaining pages that open. The pages and options vary 

based on the components selected.  
6. On the Modification Complete page, select Close. 

 

After installing the FactoryTalk Batch Server, FactoryTalk eProcedure Server, 
FactoryTalk Batch View Server, and FactoryTalk Event Archiver components 
there are several settings that should be configured before putting the system 
into production. Review these tasks to determine which items are applicable 
to your installation: 

• Configure the FactoryTalk network directory 
• Configure SQL Server to enable FactoryTalk Event Archiver with 

Reporting Services 
• Grant access to the FactoryTalk Batch directory on the SQL Server 

computer 
• Add a server to the FactoryTalk Batch system 
• Configure event log settings 
• Create a shared directory 
• Configure server options 
• Define redundant servers 
• Set security on logs and journals folders 
• Configure FactoryTalk Batch configuration users 

The install created Batch_Configuration, a local Windows user group, on the 
Batch Server machine.    

To configure FactoryTalk Batch configuration users: 
1. Add Windows users to the Batch_Configuration group for those users 

that must be able to change the batch project settings, such as the 
location of the area model and recipes.  

2. Log off and then log back in to enable the new configuration. 

If you are installing FactoryTalk Batch components on a new system, 
FactoryTalk Batch installation will install FactoryTalk Services Platform and 
configure the computer as the FactoryTalk network directory server for the 
rest of the system. After installing additional components, use the Specify 
FactoryTalk Directory Location utility to point each computer in the network 
to the FactoryTalk Directory network directory server.  

Post-installation tasks  
for FactoryTalk  
Batch components 

Configure FactoryTalk 
Batch configuration users 

Configure the FactoryTalk 
network directory 
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To configure a network directory client computer 
1. On each participating network directory client computer, go to 

Rockwell Software > Specify FactoryTalk Directory Location. 
2. At the prompt, log on to the network directory with a Windows 

Administrator account. 
3. In FactoryTalk Directory Server Location Utility, select Browse. 
4. In FactoryTalk Directory Server Configuration, select Remote 

computer, then specify the name of the computer to use as the 
network directory server, and select OK. 

5. When prompted, log on to the network directory. 

If single sign-on is enabled on the computer when the location of the 
network directory server changes, the single sign-on session 
terminates and you must log on to the new network directory server. 
The user name and password entered become the new single sign-on 
credentials for all participating FactoryTalk products on the computer. 

6. When prompted, restart the computer. 

 

If including reporting services in the FactoryTalk Batch system installation, 
you must configure SQL Server to enable FactoryTalk Event Archiver with 
Reporting Services to connect to and insert records into the FactoryTalk 
Batch database. This procedure uses SQL Server Management Studio to set 
up permissions for the BatchHistoryEx database. 

See the FactoryTalk Event Archiver User Guide to configure the reporting option 
for End of Batch or Incremental. 

IMPORTANT All users of the FactoryTalk Batch Reporting Services must have a user login and read 
and write access to the source databases, such as BatchHistoryEx or the FactoryTalk® 
Alarms and Events FTAE_Historian databases. Add any additional users or groups when 
adding the login account for the FactoryTalk Batch Server.  

To configure SQL Server 2019 or SQL Server 2022 to enable 
FactoryTalk Event Archiver with Reporting Services 

1. Start SQL Server Management Studio. 
2. In Connect to Server for Server type, select Database Engine. 
3. Confirm the server name and authentication method are correct, then 

select Connect. 
4. In Object Explorer, expand Security > Logins. 
5. Right-click Logins and select New Login to add a FactoryTalk Batch 

Server user login. 
6. In Login name, type the name of the Batch Server user account. 
7. Select Search to validate the account is correct. 
8. In Default database, select BatchHistoryEx. 

Configure SQL Server 2019 
or SQL Server 2022 to 
enable FactoryTalk Event 
Archiver with  
Reporting Services 



Chapter 3  Install FactoryTalk Batch Server, FactoryTalk eProcedure Server, and FactoryTalk  
Event Archiver 

 

 Rockwell Automation Publication BATCH-IN002E-EN-D - November 2023 37 
 

9. Under Select a page, select User Mapping. 
10. Under Users mapped to this login select the checkbox for the 

BatchHistoryEX database. 
11. Under Database role membership for: <database name> select the 

checkboxes for db_datareader and db_datawriter then select OK. 

 
Tip: Confirm that <database name> has been replaced with 
BatchHistoryEX. Each database is configured independently. Role 
membership added for the master database does not transfer to other 
databases. 

12. In Object Explorer, expand Databases, right-click the BatchHistoryEx 
database, and select Properties. 

13. Under Select a page, select Permissions. 
14. Under Users or roles select the Batch Server user account. 
15. Under Permissions for <SQL_Server_name\user_account>: select the 

checkboxes in the Grant column for these permissions: 

• Insert 
• Connect 
• Execute 

 
Tip: Confirm that <user_account> has been replaced with the Batch Server 
user account. Each user account permission set is configured 
independently. 

16. Select OK to apply the configuration. 

 

By default, the FactoryTalk Batch directory on the SQL Server computer is not 
shared to domain users. Therefore, domain users cannot access the 
appropriate application .log file when an error message refers them to it.  

To enable domain users to read application logs, share the FactoryTalk Batch 
directory on the SQL Server computer in the FactoryTalk Batch system to 
domain users and give the share Read-Only permissions. 

If your FactoryTalk Batch system includes a Material Manager server you will 
need to configure the system with the newly installed servers and synchronize 
your FactoryTalk Batch system. The synchronization process copies the 
network model data from your computer to each of the computers included in 
your FactoryTalk Batch system. Use the Network Editor utility to perform this 
procedure. 

The Network Editor is a utility that allows you to indicate where other 
FactoryTalk Batch and/or FactoryTalk Batch Material Manager servers are 
located on the network. This network configuration information simplifies 
integration with other FactoryTalk products and the process of reconfiguring 
a system. The computers running FactoryTalk Batch components that have 
been installed need to be present in the network model for your system. Each 
Material Manager server can support ten FactoryTalk Batch servers. After the 
initial install each computer has a local network model that needs to be 
synchronized for the components to work together.  

Grant access to the 
FactoryTalk Batch directory 
on the SQL Server computer 

Add a server to the 
FactoryTalk Batch system 
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The Network Editor is installed automatically with the FactoryTalk Batch and 
Material Servers. 

To select a network model 
1. Open the Network Editor. 
2. In the Network Editor toolbar, click the Select Network Model button.  
3. Type the computer name in the "Enter the object name to select" area, 

or click the Advanced button to search for a computer. 
4. Click OK. 

To add a server 
1. Open the Network Editor. 
2. In the Hierarchy pane, select the type of server to add. 
3. Click Add Server.  
4. In the Alias box, type an alias name. This is the name that displays in 

the Network Editor. 
5. In the Computer Name box, type the computer name, or use the 

browse button to locate and select the computer from the list of 
computers on your domain. 

6. Click the Synchronize button. 
7. Click OK. 

The Network Editor refreshes and the results of the synchronization 
process display in the Results pane. 

 

The Windows Event Log service records application, system, and security 
information.  

Logging events can fill log space very quickly. If logging is enabled, we 
recommend that you configure the Windows Application and Services logs on 
Windows Server to use the Overwrite events as needed setting.  

For more information about event log settings, see Modify Event Log Settings 
in the FactoryTalk Batch Administrator Guide. 

 

A shared directory allows computers on the network to read from and write to 
a common recipe, area model, or data file.  

The FactoryTalk Batch installation creates a shared directory named 
BATCHCTL where the FactoryTalk Batch software is installed (the default is 
C:\Program Files (x86)\Rockwell Software\Batch).  

If you installed your project files in a different directory, configure that 
directory as a shared directory.  

Event log settings 

Create a shared directory 
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IMPORTANT Administrative privileges are required to create a shared directory. 

To create a shared directory 
1. Navigate to the project file directory, then right-click the folder, and 

select the sharing option.  
2. Use the File Sharing dialog box to add each user or user group name 

that requires access to the project file directory. 
3. Repeat for each user or user group, including the user accounts used 

by the FactoryTalk Batch Server and FactoryTalk Event Archiver. 
4. Select Share. 

 

Configure FactoryTalk Batch to store batch journals and batch restart 
information in two separate locations. If there is a hardware failure on the 
primary FactoryTalk Batch Server computer, using a secondary server allows 
for a manual failover.  

The second computer must be capable of running the server. Redundant 
servers are defined by specifying the primary and secondary restart paths. If 
the system experiences a failure, these paths indicate where system files are 
written. If a secondary path is not specified, FactoryTalk Batch does not write 
any secondary files.  

FactoryTalk Batch can be configured to store batch journals and batch restart 
information in two separate locations.  

 
Tip: You must be added to the Batch_Configuration group on the FactoryTalk Batch Server machine 
to have rights to change the FactoryTalk Batch project settings. After adding the users, log out and 
then back in to the Windows session for the change to take effect. 

To define redundant servers 
1. From the FactoryTalk Batch Equipment Editor Options menu, click 

Server Options. 
2. Select the Restart Control tab. 

 

 
3. In the Restart Type area, click on a selection, or accept the default, 

Warm All Restart. 

Define redundant  
servers (optional) 
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4. Click the Primary Path browse button. The Select Directory dialog box 
opens. 

5. Select the MyProject\restart folder located in the BATCHCTL share on 
the primary server’s hard drive (the default is c:\Program Files 
(x86)\Rockwell Software\Batch\MyProject\restart), and then click 
OK. 

6. Click the Secondary Path browse button. The Select Directory dialog 
box opens. 

7. Locate and select the MyProject\restart folder located in the 
BATCHCTL share on the secondary server’s hard drive, and then click 
OK. 

8. Repeat steps 1 through 7 on the redundant server computer, selecting 
the Batch\MyProject\restart folder on the redundant server as the 
Primary Path. The Secondary Path can remain blank or point to 
another redundant server. Additionally, you must configure a data 
server to communicate with the process controller on the redundant 
server computer. The redundant server computer needs to 
communicate with the process controller that is running the phase 
logic. 

 
Tip: You must also verify that the primary and secondary journal project 
directories are defined.  

 

Before configuring the FactoryTalk Batch Server, make sure that all project 
directories are shared. Configure the FactoryTalk Batch Server using the 
FactoryTalk Batch Equipment Editor Server Options dialog box. 

 
Tip: In FactoryTalk Batch Equipment Editor, access Options > Server Options, Project 
Settings tab. Verify that the location listed in Initialization File Name is where the 
batchsvr.ini resides on the computer.  

Server options has several tabs: 

• Project settings. Used to set directories for the Primary Journal, 
Secondary Journal, Error Logging, Instructions (if you are using 
FactoryTalk eProcedure), and Equipment Database, configure recipe 
storage locations, and enable recipe versioning. 

 
Tip: Users must be added to the Batch_Configuration group on the batch server machine in 
order to have rights to change the batch project settings. After adding the users, the windows 
session must be logged out and logged back in to take effect. 

• Restart Control. Used to specify a restart method to initiate in the 
event of a server computer failure.  

• Batch Reporting. Used to select the reporting application for 
generating Batch reports and archiving Batch data. 

• Archiver Event Filters. Used to determine what electronic Batch 
record data FactoryTalk Event Archiver writes to the Batch history 
database. 

Configure server options 
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• Batch Server. Used to select and configure FactoryTalk Batch Server 
options (including the hold propagation type), watchdog 
communications timeout settings, FactoryTalk Event Archiver log file 
size, minimum disk space required to add a batch, default batch ID, 
and whether to enable/disable event journal signatures. 

• Cross Invocation Descriptors and Defaults. Used to specify cross 
invocation labels and set default cross invocation strings for different 
resource types. 

• Hyperlink Descriptors and Defaults. Specifies the hyperlink labels and 
default values used with different resource types. This feature is used 
in conjunction with FactoryTalk eProcedure only. 

• Material Policies. Used define what action to take when the 
communication to the Material Server is lost and how to respond to a 
split feed. These features are used in conjunction with FactoryTalk 
Batch Material Manager only. 

Make sure to configure the FactoryTalk Batch Server to allow each network 
computer to read from and write to the appropriate project directories and 
the FactoryTalk Batch Server and Archiver initialization files.  

Changing items such as FactoryTalk Batch Server information, area model, 
and the error logging directory take effect when the server is restarted. 
Changing items such as the recipe directory and batch journal directory take 
effect the next time the server accesses these items. None of the items in 
FactoryTalk Event Archiver configuration require the server to be restarted. 
These changes take effect the next time the server needs that configuration 
item. 

IMPORTANT FactoryTalk Batch does not support the use of mapped drives. Do not use mapped 
drives for project directories. 

For more information about configuring server options, see the FactoryTalk 
Batch Administrator Guide. 

 

To prevent losing data in the log files and the event journal (.evt) files, set 
security permissions on the logs and event journal folders. The system 
administrator determines who needs access to these files and assigns the 
appropriate permissions. The accounts under which the FactoryTalk Batch 
Server and FactoryTalk Event Archiver are running must be given full access 
to these folders.  

IMPORTANT FactoryTalk Batch Server continues writing information to log files and event 
journals (.evt or .evtj) even when they are open. If a file is opened and then saved, 
data that may have been written to the event journal or log file while the file is open 
is lost. 
Use Notepad to open log files. If a log file is opened with a program other than 
Notepad, the FactoryTalk Batch Server may not run due to an access error. 

Set security on logs and 
journals folders 
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To set security on logs and journals folders 
1. In Windows Explorer, locate the folder. 
2. Right-click the folder and then select Properties. 
3. Select the Security tab, select Edit, and then select Add. 
4. From the Select Users, Computers, Service Accounts, or Groups dialog 

box, select Advanced and then select Find Now. 
5. Select a user or group from the Search results list, and then select OK. 
6. Repeat for each user or group that requires access to the folder. 

 
Tip: Be sure to add the FactoryTalk Batch Server user account and then 
configure the account with Full Control permissions. 

7. Select OK to return to the Properties dialog box. 
8. From the Group or user name list, select a user or group, and then 

select the permissions in the Permissions area. Repeat for each user or 
group. 

9. Select OK. 
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Chapter 4 

Install FactoryTalk Batch View HMI Controls on 
FactoryTalk View SE Display Clients 

When installing FactoryTalk Batch View HMI Controls on FactoryTalk View 
SE Display Client use these guidelines: 

• Install the FactoryTalk Batch Server first.  
• Instructions for installing the FactoryTalk Batch HMI Controls on 

FactoryTalk View SE Display Clients  re based on installing clients on 
a computer networked with other FactoryTalk Batch system 
computers. 

 
Tip: We recommend using the default installation directories for all components. 

Use this checklist to help you successfully set up the FactoryTalk Batch HMI 
Controls on FactoryTalk View SE Display Clients:  

Pre-Installation administration tasks 

 Tasks Notes 
 Obtain administrator privileges on target 

computer 
 

 Update Windows firewall settings  

 Set the system date and time  
Installation 
 Install the FactoryTalk Batch HMI Controls  

 

 

Installing the FactoryTalk Batch View HMI Controls places controls within an 
existing installation of the FactoryTalk View SE Display Client :  

 
Tip: Prerequisite checks are run automatically to verify that the required software is present on the 
target computer. If an issue occurs during installation, suggested resolution steps are provided. 

To install the FactoryTalk Batch View HMI Controls on FactoryTalk 
View SE Display Client 

1. Run Setup.exe. 
2. On the Setup page, select Customize.  
3. On the Customize page: 

Install the FactoryTalk 
Batch View HMI Controls 
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• Select FactoryTalk Batch View HMI Controls v3.00 and FactoryTalk 
Batch View Server. 

• Clear all other selections.  
• Select Next. 

4. On the Options page, select Next. 
5. On the Batch System Details page, complete these items: 

• Under User Account, in User Name, enter the domain name\user 
name used to install the FactoryTalk Batch Server. 

• Select one formatted type generated by the FactoryTalk Batch 
Server. 

• Select Install.  

6. On the End User License Agreements page, review the agreement and 
select Accept all. 

7. If prompted on the That's it page, restart the computer.  
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Chapter 5 

Install FactoryTalk Batch Material Manager 
Server components 

Use FactoryTalk Batch Material Manager to track material consumption in 
FactoryTalk Batch recipes. 

 
Tip: We recommend using the default installation directories for all components. 

Use this checklist to help you successfully set up the FactoryTalk Batch 
Material Manager environment: 

Pre-Installation administration tasks 

 Tasks Notes 
 Obtain administrator privileges on target 

computer 
 

 Create users and user groups  

 Update Windows firewall settings  

 Configure the remote registry service  
 Set the system date and time  
 Prepare the SQL Server installation  

 Configure Microsoft Message Queuing Service 
• Configure the Windows Server operating 

system 
• Configure the Windows desktop operating 

system 

 

Installation 
 Install the FactoryTalk Batch Material Manager 

Server 
 

Post-installation tasks 

 Identify the material database  
 Add a server to the FactoryTalk Batch system  

 

 

Use this procedure to install the FactoryTalk Batch Material Manager Server.  

 
Tip: Prerequisite checks are run automatically to verify that the required software is present on the 
target computer. If an issue occurs during installation, suggested resolution steps are provided. 

Install the FactoryTalk 
Batch Material Manager 
Server 
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To install the FactoryTalk Batch Material Manager Server 
1. Run Setup.exe. 
2. On the Setup page, select Customize.  
3. On the Customize page: 

• Select and expand FactoryTalk Batch Material Manager v16.00.  
• Select Server Components. 
• Clear all other selections.  

 
Tip: FactoryTalk Services Platform v6.40.00 is always installed with FactoryTalk Batch 
Material Manager v16.00. 

• Select Next. 

4. In FactoryTalk Services Platform page, select the directory type that 
you want to create, and then select Next. 

5. On the Permission Requested page, select Yes, allow changes to this 
computer, and then select Next. 

Installing this component will make these changes to users and 
groups: 

• The user input in Material System Details will be added to the 
MTUsers group and Administrators group. 

• MTUsers will be assigned permissions to the MaterialBasedRecipe 
database 

• MTBatchServer will be added to the MTBatchServer role. 
• MTLotAuthor will be added to the MTLotAuthor role. 
• MTMaterialAuthor will be added to the MTMaterialAuthor role. 
• MTMaterialViewer will be added to MTMaterialViewer role. 

6. On the Options page: 

• Under Material Activity Journal select Record activity to the 
MaterialBasedRecipe_MAJ database if you will be using 
FactoryTalk Event Archiver reporting with FactoryTalk Batch 
Material Manager. 

• Select Next. 

7. On the Material System Details page, complete these fields:  

• Under User Account in User Name, enter the domain\user name for 
user account created for the FactoryTalk Batch Material Manager 
Server to run under. If the user account is in the current domain, 
the domain does not need to be specified. 

• In Password enter the password for the domain\user name.  
• Select Install. 

8. On the End User License Agreements page, review the agreement and 
select Accept all. 

9. (optional) If prompted on the Almost There page, select Activate your 
software, and then select Next. 

10. If prompted on the That's it page, restart the computer.  
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After installing the FactoryTalk Batch Material Manager Server, complete 
these configuration items before transitioning the system into production: 

• Identify the material database on page 47 
• Synchronize your FactoryTalk Batch system(If the Material Manager 

Server is on a different server than the FactoryTalk Batch server) 

Configure the FactoryTalk Batch Material Manager Server with the location of 
the SQL database that contains the materials for the recipes. 

To identify the material database 
1. Navigate to Rockwell Software > Network Editor.  

The Network Editor window opens with the Material Server selected 
by default. 

2. Select Configure. The Configure MaterialTrack dialog box opens. The 
default database is materialbasedrecipe. 

3. In the MaterialTrack Database box, enter the name of the database, 
and select OK. 

IMPORTANT The Network Editor does not verify database names. Changes 
made to the database name are immediate for the clients and 
servers. If the database name is invalid, the Material Editor will 
not open.  
Before changing the database name, check the spelling of the 
database name and synchronize the Network Editor. After 
changing the database name, confirm that the Material Editor 
opens and reads the databases. 

4. Select Synchronize. 
5. Select File > Exit, and then select Yes to exit the Network Editor. 

 

Post-installation for 
FactoryTalk Batch Material 
Manager Server  

Identify the  
material database 
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Chapter 6 

Install FactoryTalk Batch Material Manager 
Client components 

This section provides instructions on how to install the FactoryTalk Batch 
Material Manager Client components.  

 
Tip: We recommend using the default installation directories for all components. 

 

Use this procedure to install the FactoryTalk Batch Material Manager Client.  

 
Tip: Prerequisite checks are run automatically to verify that the required software is present on the 
target computer. If an issue occurs during installation, suggested resolution steps are provided. 

To install the FactoryTalk Batch Material Manager Client 
1. Run Setup.exe. 
2. On the Customize page: 

• Select and expand FactoryTalk Batch Material Manager v16.00.  
• Select Client Components. 
• Clear all other selections.  

 
Tip: FactoryTalk Services Platform v6.40.00 is always installed with FactoryTalk Batch 
Material Manager v16.00. 

• Select Next. 

3. If prompted, on the Material System Details page, specify the name of 
a computer that has the FactoryTalk Batch Material Manager Server 
installed, and select Install.  

4. On the End User License Agreements page, review the agreement, and 
select Accept all. 

5. On the That's it page, if prompted to do so, restart your computer. 

 

 

Install the FactoryTalk 
Batch Material Manager 
Client components 
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Chapter 7 

FactoryTalk Activation 

FactoryTalk® Activation Manager is the license application for FactoryTalk 
Batch and eProcedure. FactoryTalk Activation Manager is not necessary on 
client installations or any FactoryTalk Batch Material Manager installations. 
At the end of the installation wizard you can activate the software or continue 
without activation. 

IMPORTANT Some features may not be available until the software is activated.  

The FactoryTalk Batch Server computer requires the FactoryTalk Activation 
Manager to enable communication with the FactoryTalk Activation Server. 
FactoryTalk Activation Manager is installed automatically on the computer 
where the FactoryTalk Batch Server resides. FactoryTalk Activation Manager 
can be installed on all FactoryTalk Batch Server computers.  

FactoryTalk Activation Manager for FactoryTalk Batch and 
eProcedure  

 

 Server that includes: 
• FactoryTalk Batch Server 
• FactoryTalk Activation Client 
• eProcedure Server 
• FactoryTalk Batch View Server  

 FactoryTalk Batch Material Manager Server and Client 

 (optional) FactoryTalk Activation Server 

 Activation files for FactoryTalk Batch and eProcedure 

 Client computer that includes: 
• FactoryTalk Batch View Client 
• eProcedure Client 
• FactoryTalk Batch View 
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IMPORTANT The FactoryTalk Batch Server checks for valid licenses and the correct number of unit 
licenses for FactoryTalk Batch and eProcedure at start up. 

FactoryTalk Activation Licensing for the FactoryTalk Batch Server 
Follow these licensing guidelines: 

• The FactoryTalk Batch Server installs the FactoryTalk Activation Server 
on the FactoryTalk Batch Server machine. 

• To obtain activation files for FactoryTalk Batch components, identify 
the Host ID of the FactoryTalk Activation Server computer. 

IMPORTANT In this scenario, the FactoryTalk Batch Server starts only if it 
finds valid activation files for FactoryTalk Batch. 

If a license does not exist on the designated FactoryTalk Activation Server, a 
prompt asks for a serial number and product key. The installer attempts to 
download the license from the licensing service. If an Internet connection is 
not available, skip the on-line activation and obtain activation files using one 
of these alternative methods: 

• Go to: https://activate.rockwellautomation.com/ 
• Use the FactoryTalk Activation Manager on a computer that has 

Internet access. 
• If Internet access is not available, call Rockwell Automation Technical 

Support and request an activation file be sent by email. 

 

Software licenses are split into a product license and multiple unit licenses. 
For example, a 30-unit FactoryTalk Batch product contains a 30-unit 
FactoryTalk Batch Server license, which includes a bundled license for 
FactoryTalk Batch Server, eProcedure Server, and FactoryTalk Batch Material 
Manager Server, and 30 new unit licenses.  

When the FactoryTalk Batch Server starts, it performs a license check to 
determine which applications have a license. It then attempts to check out 
individual unit licenses up to the number of units specified in the area model. 
The FactoryTalk Batch Server then sets the maximum number of allowable 
units to the total number of successful individual unit license checkouts. 

 

Cumulative unit licensing 

https://activate.rockwellautomation.com/
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Chapter 8 

Upgrade FactoryTalk Batch 

If you have an existing FactoryTalk Batch system, you can upgrade the 
environment instead of doing a new installation.  

Use this checklist to help you to successfully upgrade the FactoryTalk Batch 
environment: 

Pre-upgrade tasks 

 Tasks Notes 
 Allow the Message Queue to clear for Material 

Manager 
 

 Export XML or RDB recipes to binary  

 Back up files  

 
FactoryTalk Batch component upgrade tasks 
 Upgrade the FactoryTalk Batch components  

Post-upgrade tasks 
 Restore back up files  

 Migrate area models from FactoryTalk Batch 
version 15.00 

 

 Migrate recipes from FactoryTalk Batch version 
15.00 

 

 (optional) Convert binary recipes to XML or RDB  
 Convert migrated recipes back to XML format 

(optional) on page 59 
 

 Convert migrated recipes back to RDB format 
(optional) 

 

 Configure recipe storage on page 60  

 

 

This section describes steps to perform before upgrading the software, 
including: 

Pre-upgrade tasks for 
FactoryTalk Batch 
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• Allowing the Message Queue to clear (Material Manager) 
• If using XML or RDB recipes, exporting them to binary 
• Backing up existing data files 

Allow the message queues for communication to clear between the 
FactoryTalk Batch Material Manager Server and the Material Activity Journal.  

IMPORTANT This procedure applies to FactoryTalk Batch Material Manager only. 

To allow the Message Queue to clear 
1. Navigate to Computer Management.  
2. In the Computer Management window, expand Services and 

Applications > Message Queuing, and then select the Private Queues 
folder.  

The list of queues is displayed in the right pane. 

3. Wait until the number of messages in the Material, Material_0, and 
material_track0-4 queues reaches 0. 

4. Close Computer Management.  

 

Before upgrading FactoryTalk Batch components to a later version, export 
recipes to binary format and delete any RDB recipe database. 

To export XML or RDB recipes to binary 
1. Back up all existing XML or RDB recipes to a new location. 
2. Open FactoryTalk Batch Recipe Editor.  
3. Select File > Export from Working Set.  
4. Select Binary Files and set the path to a location to store the binary 

files.  
5. Select Export.  

IMPORTANT • When installing FactoryTalk Batch 16.00 with RDB support, 
FactoryTalk Batch recreates the default MasterRecipes 
database.  

• FactoryTalk Batch does not recreate any custom database 
that stores recipes during installation.  

• When storing recipes from FactoryTalk Batch Recipe Editor 
on a remote SQL Server, run the Windows Firewall 
Configuration Utility to add TCP Port 1433 as an exception in 
the Windows Firewall.  

 

Before upgrading the previous versions of FactoryTalk Batch components, 
close all applications, and stop all FactoryTalk Batch services, including the 
eProcedure Server, then back up the configuration and data files.  

Allow the Message Queue to 
clear for FactoryTalk Batch 
Material Manager 

Export XML or RDB recipes 
to binary 

Back up files 
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Tip: Back up the .ini files so that you can revert to the previous installation 
if needed. 

FactoryTalk Batch Server files 
• Batcharc.ini file (Batch\bin folder) (if customized) 
• Batchmbs.ini (Batch\bin folder) 
• Batchsim.ini file (Batch\bin folder) 
• Batchsvr.ini file (Batch\bin folder) 
• BatchIDCreation.dll (Batch\bin folder) (if customized) 
• BatchID Custom folder (if customized) 
• Simulator configuration files (.sim files in any folder) 
• DSDF files (Batch\Data Servers folder) (if customized) 

FactoryTalk Batch Client files 
• Area models (Batch\<project name>\recipes folder) 
• Recipes folders and contents (Batch\<project name>\recipes folder) 

IMPORTANT If using Security Authority to secure area models and recipes, 
back up the FactoryTalk Network Directory Security Authority 
Identifier (SAI). This provides a means of recovery to any binary 
area models or recipes linked to an SAI that would otherwise 
not be opened if the SAI was lost.   

• Customized *.bmp files (Batch\bmp folder) 
• Batcheqp.ini file (Batch\bin folder) 
• Batchrcp.ini file (Batch\bin folder) 

FactoryTalk eProcedure files 

Close all applications and stop all Batch services before backing up files. 

• Customized Instruction files  

FactoryTalk Material Manager databases and files 
Close all applications and stop all FactoryTalk Batch services before backing 
up files. 

• Customized Instruction files  
• MaterialBasedRecipe database 
• MaterialBasedRecipe_MAJ database 
• Any other material-based recipe databases unique to the facility 

FactoryTalk Event Archiver database and files 
• BatchHistory or BatchHistoryEx database  
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• Customized reports 

After backing up files, install the latest versions of FactoryTalk Batch 
components to upgrade to the latest version. 

• Install the FactoryTalk Batch components on page 30 
• Install the Material Manager Server on page 45 
• Install the Material Manager Client on page 49 

After upgrading the FactoryTalk Batch software, perform these tasks before 
putting the system into production: 

• Restoring back-up files 
• Migrating area models and binary recipes, including XML or RDB 

recipes that were exported to binary before the upgrade 
• (Optional) Converting binary recipes back to XML or RDB 

Before opening the FactoryTalk Batch Recipe Editor or the FactoryTalk Batch 
Equipment Editor, restore backed up files to their original locations. This 
preserves the Batch Server and Client files and the databases for use with the 
upgraded version of FactoryTalk Batch. 

IMPORTANT Do not delete installed FactoryTalk Batch, eProcedure, or Material Manager product 
files from their installed locations.  
Removing product files from their original locations may cause unexpected failures 
and error messages in the Microsoft Install Resiliency feature. Instead, replace or 
overwrite the product files with other files of the same name.  
For example, overwrite BatchIDCreation.dll, RAMSCustom.dll and other hot fix files, 
but never delete and then replace these files. 

FactoryTalk Batch Server files  
Restore these FactoryTalk Batch Server files by placing them in the 
appropriate directories. 

• Batcharc.ini (Batch\bin folder) (if customized). Prior to restoring a 
customized Batcharc.ini file: 

• Open the newly installed Batcharc.ini file.  
• Copy the ArchiverTableName and ArchiverConnectionString lines.  
• Paste these lines into the back up Batcharc.ini file, and then use that 

file as the restore file.  

Restoring the Batcharc.ini file without copying these lines may 
revert the newly created connection string. If this occurs, restore 
the new connection string with the Archiver Setup application. 

• BatchIDCreation.dll (Batch\bin folder) (if customized) 
• BatchID Custom folder (if customized) 
• Simulator configuration files (.sim files in any folder) 
• DSDF files (Batch\Data Servers folder) (if customized) 

Upgrade the FactoryTalk 
Batch components 

Post-upgrade tasks 

Restore backup files 
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FactoryTalk Batch Client files 
Restore these FactoryTalk Batch Client files by placing them in the 
appropriate directories. 

• Customized *.bmp files (Batch\bmp folder) 
• Binary recipes (if using XML or RDB, first update the exported binary 

versions after upgrading the FactoryTalk Batch software, and then 
export them back to XML or RDB format) 

• Area models (Batch\<project name>\recipes folder) 
IMPORTANT Do not restore the FactoryTalk Batch version 13 module .ini 

files. The .ini files are only restored when you are reverting to 
the previous installation. 

FactoryTalk eProcedure files 
Restore these FactoryTalk eProcedure files to their original locations: 

• Customized Instruction files  

FactoryTalk Material Manager databases and files 
Restore these FactoryTalk Material Manager files and databases to their 
original locations: 

• Customized Instruction files  
• Materialserver.log file (Batch\bin folder) 
• MaterialBasedRecipe database 
• MaterialBasedRecipe_MAJ database 
• Any other material-based recipe databases unique to the facility 

 
Tip: After restoring the material database, use SQL Server Management Studio to run the 
MaterialTrack_db_schema_Procedures.sql script, which deletes the old stored procedures 
and adds the new stored procedures. The script is located at: C:\Program Files (x86)\Rockwell 
Software\Batch\Scripts. 

FactoryTalk Event Archiver databases and files 
During installation of FactoryTalk Event Archiveran option to overwrite the 
existing database or migrate data from the BatchHistory or BatchHistoryEx 
database to the new FactoryTalk Batch database is provided. Because of this, 
you do not need to restore the backup files created before the upgrade. Those 
files were created to support reverting your system to the previous version if 
necessary.  
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IMPORTANT Updates to the BatchHistoryEx database overwrite any customizations made to 
FactoryTalk Event Archiver reports. You will need to recreate all customized reports 
after the upgrade.  
Do not attempt to perform a full database backup and restore instead of allowing the 
installation program to overwrite or migrate the databases. A full database backup 
and restore will overwrite changes made to the schema as part of the upgrade. 

 

After upgrading FactoryTalk Batch you must migrate any area models and 
recipes to the 16.00 schema so they can be used by the system. 

Prerequisites 
• Use the FactoryTalk Administration Console to confirm that any linked 

FactoryTalk and Windows users and groups that are required by 
signature templates are configured in the FactoryTalk Network 
Directory.  

To migrate area models from FactoryTalk Batch version 15.00 
1. Open FactoryTalk Batch Equipment Editor. 
2. Select File > Open.  
3. Navigate to and select the version 15 area model.  
4. When prompted to update the equipment database, select Yes. 

If the area model uses signature templates, and no FactoryTalk users 
and groups match, the Security Permissions in the signature template 
are empty and require configuration. FactoryTalk Batch Equipment 
Editor displays a list of signature templates on which translation of 
security descriptors failed in the Invalid Signoffs dialog box.  

5. Make a note of the affected templates and select OK. The migration 
completes. 

IMPORTANT If the Phase Failure enumeration set of an area model has 
ordinal values greater than 32767, reconfigure the values after 
migration. See System enumeration sets in the FactoryTalk 
Batch Equipment Editor User Guide. 

6. Save the area model. 
7. Open each signature template and configure the Signoff Permissions. 

See Create a Signature Template in the FactoryTalk Batch Equipment 
Editor User Guide for detailed instructions. 

 

The FactoryTalk Batch Recipe Editor schema has changed from version 15.00 
to version 16.00. When opening the Recipe Editor, some recipes might require 
translation before using the Recipe Editor. 

These instructions are for recipes stored in the default binary files and for 
migrating the binary recipes export of XML or RDB recipes. 

Migrate area models from 
FactoryTalk Batch  
version 15.00 

Migrate recipes from 
FactoryTalk Batch  
version 15.00 
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Prerequisites 
• Export XML or RDB recipes to binary on page 54 

To migrate recipes from FactoryTalk Batch version 15.00 
1. Open FactoryTalk Batch Equipment Editor.  
2. Select Options > Server Options.  
3. In the Server Options dialog box, Store Recipes Using section, select 

Binary Files and set the path to the binary files. 
4. Open the binary area model that was backed up before upgrading. 

FactoryTalk Batch Equipment Editor prompts to migrate the area 
model. Accept the migration and then save the file. 

5. If errors occur during migration, stop and address the errors in the 
area model. 

6. Open FactoryTalk Batch Recipe Editor. 
7. If prompted to translate recipes, select Yes.  
8. (optional) If auditing is enabled, enter appropriate comments in the 

Audit Comments dialog box 
9. Select OK. The Recipes Requiring Verification dialog box displays all 

recipes that require verification. 
10. (optional) Select Verify All to verify the listed recipes. The Verification 

Process Results dialog box opens. If any errors occur during 
translation, they are displayed in the top portion of the dialog box.  

11. Double-click an error message to open the recipe to the error. 

 
Tip: Select all of the error or warning text and copy it to a text editor to use 
the list while addressing the errors.  

12. Close the dialog box. The verified recipes are copied back into the 
working set of recipes. 

13. (optional) If auditing is enabled, the Audit Comments dialog box 
opens prior to saving the recipes. Enter appropriate comments, and 
then select OK. 

 

After installing the latest version of FactoryTalk Batch components and 
migrating the area model, convert binary format recipes to an XML or RDB 
format if needed. 

 

Use this procedure to convert updated binary recipes back to XML format.  

To convert migrated recipes back to XML format  
1. Open FactoryTalk Batch Equipment Editor.  
2. Select Options > Server Options.  

Convert binary recipes to 
XML or RDB 

Convert migrated recipes 
back to XML format 
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3. In the Server Options dialog box, Store Recipes Using section, select 
XML Files and set the path to the XML recipe location. 

4. Open FactoryTalk Batch Recipe Editor.  
5. Select File > Import Recipe Into Working Set.  
6. In the Import Recipe into XML directory dialog box, select Binary 

Files and set the path to the location of the translated binary files.  
7. In the Recipe Name list, select all the recipes, and then select Import. 

Recipes are imported into the working set of recipes in XML format. 

See also 

Convert binary recipes to XML or RDB on page 59 

Use this procedure to convert migrated binary recipes back to RDB format.  

To convert migrated recipes back to RDB format 
1. In FactoryTalk Batch Equipment Editor, select Options > Server 

Options.  
2. In the Server Options dialog box, under Store Recipes Using, select 

SQL Server Database. 
3. Select the node and database to store recipes.  

 
Tip: The default database is masterrecipes. Substitute a different database 
name, if needed.  

4. Open FactoryTalk Batch Recipe Editor.  
5. Select File > Import Recipe Into Working Set.  
6. In the Import Recipe into Database dialog box, select Binary Files and 

set the path to the location of the migrated binary files.  
7. In the Recipe Name list, select all the recipes, and then select Import to 

convert the recipes to RDB format and store in the database. 

See also 
Convert binary recipes to XML or RDB on page 59 

Recipes can be stored either as binary files, in a SQL Server Database, or as 
XML files 

To configure recipe storage 
1. Open FactoryTalk Batch Equipment Editor. 
2. On the menu bar, select Options to open the Server Options dialog box 
3. Under Store Recipes Using, select one of these options for storing 

recipes: 

Convert migrated recipes 
back to RDB format  

Configure recipe storage 
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• Binary Files (default format): Stores recipes in separate files 
according to the recipe level and specified directory: 

Stores procedures as .bpc files 
Stores unit procedures as .upc files 
Stores operations as .uop files 

• Microsoft SQL Server Database: Stores recipes in a SQL Server 
database. 

 
Tip: If SQL Server is not installed on the same computer as the client, 
perform a custom installation of SQL Server and install the Client Tools 
Connectivity option. This displays a list of available SQL Server databases in 
the Server Options dialog box.  

• XML Files: Stores recipes in separate .xml files:  

Stores procedures as .pxml files 
Stores unit procedures as .uxml files  
Stores operations as .oxml files 

4. Select OK to apply the configuration settings. 
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Chapter 9 

Troubleshoot FactoryTalk Batch installation  
or upgrade 

At release time, this application presents certain circumstances and errors 
that require troubleshooting. This section supplies troubleshooting topics that 
indicate possible causes and solutions. 

• Manually configuring the Windows Firewall 
• Defining or resetting a disabled Administrator account 
• Communication with the FactoryTalk Batch Server timing out 
• Recreating the masterrecipes database 

 

If the Windows Firewall is enabled, and not externally controlled, the 
Windows Firewall Configuration Utility runs automatically. If this utility 
does not run automatically, manually run it on each computer in the 
FactoryTalk Batch system after installing servers or clients.  

To manually configure the Windows Firewall 
1. Navigate to All Programs > Rockwell Software > FactoryTalk Tools > 

Windows Firewall Configuration Utility. The configuration utility 
starts.  

2. If the firewall is not enabled, a dialog box may open. Select Yes to 
enable the firewall and continue.  

3. On the Rockwell Software Windows Firewall Configuration Utility 
dialog box, review the list of suggested changes and select Accept. 

4. On the Confirm Windows Firewall Changes dialog box, verify that the 
New Firewall State is set to On with Exceptions.  

5. Select OK.  

For a complete list of the exceptions made by the Windows Firewall 
Configuration Utility, refer to FactoryTalk Batch Windows Firewall 
exceptions in the FactoryTalk Batch Administrator Guide. 

 

The FactoryTalk Directory Configuration Wizard runs silently during the 
FactoryTalk Service Platform installation or upgrade. Run the wizard 
manually to define or reset a disabled Administrator account. FactoryTalk 
Batch and FactoryTalk Batch ActiveX Controls store client configuration 
settings in the Local and Network Directory. 

Manually configure the 
Windows Firewall 

Define or reset a  
disabled FactoryTalk  
Administrator account 
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To define or reset a disabled FactoryTalk Administrator account 
1. Open the FactoryTalk Directory Configuration Wizard located within 

the installed FactoryTalk Batch applications. The FactoryTalk 
Directory Configuration Wizard opens.   

2. Select one or more options, and then select Next. 

• Configure the FactoryTalk Network Directory 
• Configure the FactoryTalk Local Directory 

3. Complete one or more pages: 

• In Reconfigure FactoryTalk Network Directory, enter the User 
name and Password for an existing Network administrator account. 
Re-enter the password in the Confirm password box, and then 
select Next. 

• In Reconfigure FactoryTalk Local Directory, enter the User name 
and Password for an existing Local administrator account. Re-enter 
the password in the Confirm password box, and then select Next.  

4. On the Summary window, select Close. 

 
Tip: For more detailed information on FactoryTalk Directory installation and 
configuration, select the Help button on the wizard, or view the FactoryTalk 
Administration Console help file (FTAdminEN.chm) located in C:\Program 
Files (x86)\Common Files\Rockwell\Help. 

See also 

Communication with Batch Server times out on page 64 

If the FactoryTalk Batch and eProcedure Servers run on a workgroup, add an 
Incoming Firewall Rule to allow the FactoryTalk Batch Service Manager to 
connect to the Server in a timely manner. For more information about adding 
an Incoming Firewall Rule, see Add an incoming firewall rule. 

Disable Administrative Approval Mode for all administrators on the 
FactoryTalk Batch Server when running on a workgroup. This ensures that 
administrators do not have to install or run programs using elevated 
privileges.  

For more information about disabling Administrative Approval, see Disable 
Administrative Approval Mode on page 68. 

 

If the database name is not masterrecipes, follow these steps to edit the .bat 
file and the createmasterrecipedb.sql script to specify the name of the 
database and recreate it.  

If the database needs to be recreated at any time, the .bat file can also be used 
to recreate it.  

Communication with 
FactoryTalk Batch Server 
times out 

Manually recreate the 
masterrecipes database 
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Tip: If Store recipes in RDB format was selected when installing FactoryTalk Batch, running the 
createmasterrecipedb.bat file is not required.  

Prerequisites 
• Use the Rockwell Software\Batch\Scripts\createmasterrecipedb.bat 

file to recreate the recipe database. 

 
Tip: This batch file uses the default database name masterrecipes. It executes these SQL 
scripts in the Batch\Scripts folder to create the database and tables: 
• createmasterrecipedb.sql 
• createrecipetables.sql 

To manually recreate the masterrecipes database 
1. Edit Batch\Scripts\createmasterrecipedb.bat using a text editor. 

Replace masterrecipes with the database filename.  
2. Edit the createmasterrecipedb.sql script using either SQL Server 

Management Studio or another editor to specify the database file 
name. 

3. Run the Batch\Scripts\createmasterrecipedb.bat file to create the 
database and tables. 
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Appendix A 

Appendix A: Windows Workgroup 

This appendix includes instructions for using FactoryTalk Batch components 
on a Windows workgroup. 

This section describes steps to configure FactoryTalk Batch to run under a 
Windows Workgroup.  

If the FactoryTalk Batch system runs under a Windows Workgroup, you will 
need to perform these additional tasks: 

• Create Windows accounts 
• Add an incoming firewall rule 
• Disable Administrative Approval Mode 

If the FactoryTalk Batch application servers use a local account, create 
Windows accounts with the same name and password on all computers in the 
workgroup.  

Add incoming firewall rules for these applications: 

• FactoryTalk Batch Server 
• eProcedure Server 
• FactoryTalk Batch Material Manager Server 

To add an incoming firewall rule 
On the computer where the component is being installed: 

1. Navigate to Windows Firewall with Advanced Security. 
2. Select Inbound Rules, right-click Inbound Rules, and then select New 

Rule.  
3. In the New Inbound Rule Wizard, select the following values: 

• In Rule Type, select Port. 
• In Protocol and Ports, select TCP and in Specific local ports, type 

49157. 
• In Action, select Allow the connection. 
• In Profile, select all profiles (Domain, Private, Public). 
• In Name, in the Name box, enter Port 49157 TCP, and then select 

Finish. 
• Verify that Port 49157 TCP rule exists in the Inbound Rules list. 
• Close Windows Firewall with Advanced Security. 

Windows Workgroup 

Create Windows accounts 

Add an incoming  
firewall rule 
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See also 
Windows Firewall settings on page 21 

Disable Administrative Approval Mode on page 68 

Disable the User Account Control: Run all administrators in Admin Approval 
Mode security policy setting on the FactoryTalk Batch Server computer when 
running on a Windows Workgroup. This ensures that users do not have to 
install or run programs using elevated privileges.  

IMPORTANT If this security setting is configured to Disabled, the Windows Security Center notifies 
you that the overall security of the operating system has been reduced. As a result of 
this change Windows User Account Control (UAC) is not used, and any security benefits 
and risk mitigations that are dependent on UAC are not present on the computer. 
Additionally, when this setting is changed, the computer must be restarted. 

To disable Administrative Approval Mode 
1. On the FactoryTalk Batch Server, navigate to Control Panel > 

Administrative Tools > Local Security Policy. 
2. Expand Local Polices and select Security Options. 
3. Locate User Account Control: Run all Administrators in Admin 

Approval Mode and double-click it. 
4. In the Local Security Setting tab, select Disabled, and then select OK. 
5. Verify that User Account Control: Run All Administrators in Admin 

Approval Mode displays as Disabled. 
6. Close the Local Security Policy window. 

See also 
Windows Firewall settings on page 21 

Add an incoming firewall rule on page 67 

 

Disable Administrative 
Approval Mode 
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Appendix B 

Appendix B: Uninstall FactoryTalk Batch  
version 16.00 

This section describes how to uninstall FactoryTalk Batch version 16.00. 

 
Tip: Users must have administrative privileges on the target computer to 
uninstall the software. 

 

Use this procedure to uninstall all FactoryTalk Batch components on the 
computer at once.   

Prerequisites 
• Close all FactoryTalk Batch applications.  
• Stop all Batch services.  

To uninstall the FactoryTalk Batch System 
1. Navigate to Control Panel > Apps & Features. 
2. Scroll down the list of installed programs and select FactoryTalk Batch 

system 16.00 and select Uninstall. 
3. A confirmation message appears with this message: 

This app and its related info will be uninstalled.  

4. Select Uninstall.  
5. A User Account Control message appears asking you to allow the 

Rockwell Automation installer to make changes to your device.  
Click Yes to continue to the uninstall program. 

6. The FactoryTalk Batch Uninstall page is displayed. The FactoryTalk 
Batch components that are installed on your system are selected.   

 
Tip: You can also select to uninstall FactoryTalk Services Platform, FactoryTalk Activation 
Manager and FactoryTalk Linx. However, those components are shared with other Rockwell 
Automation software and should only be removed if no other Rockwell Automation software is 
installed.. 

7. Select Uninstall. 

When the uninstallation completes you can view a summary of the software 
that was removed.  

Uninstall the FactoryTalk 
Batch system 
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See also 
Uninstall the FactoryTalk Batch components on page 56 

Uninstall Material Manager on page 70 

Delete the default directories on page 71 

Delete databases on page 71 

As an alternative to uninstalling the entire FactoryTalk Batch System, you can 
uninstall unnecessary components and keep useful components. Multiple 
components can be selected. 

Prerequisites 
• Close all FactoryTalk Batch applications.  
• Stop all Batch services.  

To uninstall a FactoryTalk Batch component  
1. Navigate to Control Panel > Apps & Features. 
2. Scroll down the list of installed programs and select a FactoryTalk 

Batch component and select Uninstall. 
3. A confirmation message appears with this message: 

This app and its related info will be uninstalled.  

4. Select Uninstall.  
5. A User Account Control message appears asking you to allow the 

Rockwell Automation installer to make changes to your device.  
Click Yes to continue to the uninstall program. 

6. The FactoryTalk Batch Uninstall page is displayed. The FactoryTalk 
Batch component that you select in step 2 is selected by default.  

 
Tip: You can choose to remove additional FactoryTalk Batch components. Any software 
component that is required by another installed component can not be removed until the 
other component is removed. 

7. Select Uninstall. 

When the uninstallation completes you can view a summary of the software 
that was removed. 

 

Uninstall FactoryTalk Batch Material Manager to move it to another server or 
to permanently uninstall FactoryTalk Batch Material Manager if it is not 
being used.  

Uninstall a FactoryTalk 
Batch component 

Uninstall FactoryTalk Batch 
Material Manager 
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Prerequisites 
• Close all FactoryTalk Batch applications.  
• Stop all Batch services.  
• Allow the Message Queue to clear 

To uninstall FactoryTalk Batch Material Manager 
1. Navigate to Control Panel > Apps & Features. 
2. Scroll down the list of installed programs and select FactoryTalk Batch 

Material Manager and select Uninstall. 
3. A confirmation message appears with this message: 

This app and its related info will be uninstalled.  

4. Select Uninstall.  
5. A User Account Control message appears asking you to allow the 

Rockwell Automation installer to make changes to your device.  
Click Yes to continue to the uninstall program. 

6. The FactoryTalk Batch Uninstall page is displayed. The FactoryTalk 
Batch Material Manager Server and Client Components are selected by 
default.  

 
Tip: You can choose to remove additional FactoryTalk Batch components. Any software 
component that is required by another installed component can not be removed until the 
other component is removed. 

7. Select Uninstall. 

When the uninstallation completes you can view a summary of the software 
that was removed. 

 

Delete the default directories or the directories of the FactoryTalk Batch 
components after uninstalling the applications to free up space on the file 
system.  

To delete the default directories 
1. In Windows Explorer, expand the Program Files (x86) folder, and 

select the Rockwell Software folder. The Batch folder displays in the 
right pane. 

2. Right-click the Batch folder and select Delete. A message box confirms 
the deletion. 

3. Select Yes. 
4. Close Windows Explorer. 

 

After uninstalling FactoryTalk Batch, delete any remaining databases in SQL 

Delete the default 
directories 

Delete databases 
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Server to free up space in the database.  

Databases that might be present are: 

• BatchHistory or BatchHistoryEx 
• MaterialBasedRecipe 
• MaterialBasedRecipe_MAJ 
• Sample2_Materials 

To delete databases 
1. Open SQL Server Management Studio and expand Databases.  
2. Right-click the database and select Delete. 
3. Click OK. 
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Rockwell Automation support 
Use these resources to access support information. 

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification 
updates. 

rok.auto/support 

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase 
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport 

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature 
Product Compatibility and Download Center 
(PCDC) 

Get help determining how products interact, check features and capabilities, and 
find associated firmware. 

rok.auto/pcdc 

 

Documentation feedback 
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at 
rok.auto/docfeedback. 

Waste Electrical and Electronic Equipment (WEEE) 

 
At the end of life, this equipment should be collected separately from any unsorted municipal waste. 

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec. 

 

http://rok.auto/support
http://rok.auto/knowledgebase
http://rok.auto/phonesupport
http://rok.auto/literature
http://rok.auto/pcdc
http://rok.auto/docfeedback
http://rok.auto/pec
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